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Talk about making my job hard(er)! Some months,
there are so many outstanding screenshots to
choose from for the magazine’s Screenshot
Showcase feature. As if that wasn’t hard enough to
sort through on a monthly basis, now this month
went to the other extreme – too few to choose from.
Oh, there were plenty of screenshots posted over
the past month. But many of them were from two
users who are “prolific screenshot posters,” and so
that we don’t feature just one user or two users in
the monthly Screenshot Showcase, we’ve limited it
to publishing just one screenshot per user per month
in the magazine. We also try to feature as many of
the different desktop environments that PCLinuxOS
users are using.
Unfortunately, a good many of the screenshots
(some very good ones, at that) had to be disallowed,
due to the fact that they were of a version of
PCLinuxOS that is not available to general users –
that being the unsupported 64 bit version that is still
in testing. Others prominently featured kernels that
are still in testing, so they had to be disallowed, as
well. Still others are disallowed because there is no
indication of which desktop environment the user is
employing, and their desktop environment
unfortunately cannot be discerned by just looking at
the image. Some users have gotten very good at
creating stealthy desktops with a nonspecific or
“desktop­agnostic” appearance.
Screenshot Showcase was started for a few
reasons. First of all, it gives the average user the
opportunity to appear and be mentioned in the
monthly magazine. Secondly, it showcases to non­
PCLinuxOS users the diversity of our great OS, as
well as some of the things that it is capable of. With
that in mind, the screenshots must be representative
of what is immediately available to new users. Third,

in a roundabout way, it pays homage to those
dedicated individuals who work so hard at
maintaining the quality and diversity of PCLinuxOS.
Through Screenshot Showcase, those developers
and maintainers can enjoy watching what the
various PCLinuxOS users are capable of doing with
their systems, given the tools that have been
provided to them.

Of course, once the 64 bit version of PCLinuxOS
becomes publicly available, then one of those
problems with collecting images from the forum for
the Screenshot Showcase entries will be solved. I
reckon that the issue of using kernels in the testing
section will also become moot. Screenshot
Showcase images are collected from the Monthly
Screenshots thread in the PCLinuxOS forum every
month, so all you have to do to be considered for
inclusion in the magazine is post your screenshots in
the forum thread. However, keep in mind some of
the other guidelines we adhere to with the decision
to include or disallow screenshots for publication in
the magazine.
The May 2012 issue represents the final installments
in the magazine’s article series on Gnome 2.32.
Everyone is bound to find something of interest,
ranging from ms_meme’s tribute to the PCLinuxOS
forum “heroes,” to an in depth look at how to use the
dd Linux command line tool.
Until next month, I bid each of you peace,
happiness, serenity and prosperity.

Welcome From The Chief Editor

http://pclinuxoshelp.com/index.php/Main_Page
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by Darrel Johnston (djohnston)
gnome­specimen
According to the Synaptic description, Gnome
Specimen is an application to “view and compare
fonts installed on your system.”
Gnome Specimen currently features:
­ A list of all fonts available (the left pane)
­ A list of font previews (the right pane)
­ Configurable preview text and font size
­ Configurable foreground and background colors
used in the preview pane”
Other than being able to change the foreground and
background colors of the preview, it has the same
basic preview functions as the PCLinuxOS Control
Center font manager (PCC > System > Manage, add
and remove fonts). The other difference is that
Gnome Specimen cannot add or delete system
fonts. It is a bit dated, having not been updated
since December 31st, 2007.

An unorthodox looking font.

This one is much more readable.

wallpapoz
Wallpapoz is a Gnome wallpaper configuration tool.
You can have a different wallpaper for each
workspace, as well as having them change
automatically on a user­defined schedule. After
installing the package using Synaptic, I had no menu
entry for it. A quick look at the supplied desktop file
showed why. The original wallpapoz.desktop file is
shown below.
[Desktop Entry]
Encoding=UTF­8
Name=Wallpapoz
GenericName=Wallpapers tool
GenericName[id]=Alat gambar latar desktop
GenericName[ja]=       
GenericName[sv]=Skrivbordsbakgrund verktyg
GenericName[de]=Wallpaper Tool
GenericName[es]=Configurar la imagen del fondo
GenericName[fr]=Outil pour les fonds d'écran
Comment=Gnome Desktop Wallpapers
Configuration Tool
Comment[id]=Alat Konfigurasi Gambar Latar
Desktop Gnome
Comment[ja]=Gnome             
   
Comment[sv]=Gnome Skrivbord Bakgrunds
Konfiguerings Verktyg
Comment[de]=Gnome Desktop­Hintergund
Konfiguration
Comment[es]=Herramienta para Configurar La
Imagen Del Fondo Del Escritorio
Comment[fr]=Outil de configuration des fonds
d'écran pour Gnome
Exec=wallpapoz
Icon=wallpapoz.png
Terminal=false
Type=Application
Categories=Utility;

Gnome 2.32:4 Miscellaneous Desktop Apps
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There is no proper category defined. Change the
Categories= line to what is shown below.
Categories=GTK;X­MandrivaLinux­System­
Configuration;Settings;
Save the edited
/usr/share/applications/wallpapoz.desktop file file to
~/.local/share/applications/wallpapoz.desktop. The
menu entry will then survive any updates to the
wallpapoz package.
To have the wallpaper changer start automatically
on login, add /usr/bin/daemon_wallpapoz to startup
apps (System > Control Center > Startup
Applications in the main menu).

When the application is first started, all desktops will
have one wallpaper defined, the currently configured
one. Each workspace will also contain the default
“rename this” for the user­definable Wallpaper field.
Double­click the entry to edit it. Click on the arrow to
the left of a workspace number to see the
wallpapers that are associated with it (center, top).
You can choose to add individual files or an entire
directory’s files to a workspace. If you choose a
directory, you can also add all subdirectories by
checking the recursive option. I chose to create two
directories, one for each workspace, and store the
wallpaper images in each workspace’s folder
(center, bottom).

Right­clicking the wallpaper group name or an
individual wallpaper in the group will bring up a
window with additional options (top, right).
This is a preview of the first wallpaper in the
Workspace1 group (center, right),
This is a preview of the first wallpaper in the
Workspace2 group (bottom, right),

Gnome 2.32: 4 Miscellaneous Desktop Apps
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You can stop and restart the daemon by clicking a
button. Click the Preferences button to open the
configuration window.
I tried setting the change interval to 0 minutes, so
that the wallpapers would never change. But, after
saving, it reverts to 1 minute. Nevertheless, this
application offers the ability to have a different
wallpaper for each workspace in Gnome2 by
checking the Change desktop wallpaper when
changing workspace option. Click the Style pulldown
menu button to choose the method of scaling the
wallpaper image to the desktop.

Here is workspace number one showing one of its
wallpapers (center, top).
Here is workspace number two showing one of its
wallpapers (center, middle).

gpass
The GNOME Password Manager lets you manage a
collection of passwords. The password collection is
stored in an encrypted file, protected by a master­
password. GPass encrypts the password file by
using Blowfish encryption. It has a heavy
dependency on a full Gnome desktop environment.
Its functions are similar to Keepass and Revelation.
This is another dated application, as the last version,
0.5.1, was released on March 25th, 2006.

Once installed, the menu entry is in the Office
section of the main menu. The first run window is
shown below.

Enter a master password.

Click the Add button to add a password for an
application.

Gnome 2.32: 4 Miscellaneous Desktop Apps
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gnome­pim
The GNOME Personal Information Manager
currently consists of:
­ gnomecal : personal calendar and todo list
­ gnomecard: contact list of friends and business
associates
After installing the gnome­pim package using
Synaptic, I had no menu entries for these
applications. There is no desktop file included for the
Gnome Calendar and Planner application, so I
created my own and stored it in the
~/.local/share/applications directory. The contents of
the desktop file are shown below.
gnomecal.desktop
[Desktop Entry]
Encoding=UTF­8
Name=Calendar & Planner
Comment=Manage your appointments and
deadlines
Exec=/usr/bin/gnomecal
Terminal=false
Type=Application
StartupNotify=false
Icon=/usr/share/icons/gnomecal.png
Categories=Utility;X­MandrivaLinux­Office­
Accessories;GTK;
X­Desktop­File­Install­Version=0.11
The Gnome Contacts Manager had a desktop file in
the /usr/share/gnome/apps/Applications directory,
but the file had no Categories= entry at all, and did
not show in the menu. Again, I created one and
saved it as
~/.local/share/applications/gnomecard.desktop. The
contents are shown below.
gnomecard.desktop
[Desktop Entry]
Encoding=UTF­8
Name=Contacts Manager

Comment=Manage your contacts
Exec=/usr/bin/gnomecard
Terminal=false
Type=Application
StartupNotify=false
Icon=/usr/share/pixmaps/gnome­gnomecard.png
Categories=Utility;X­MandrivaLinux­Office­
Accessories;GTK;
X­Desktop­File­Install­Version=0.11
I found the calendar and planner to be a bit counter
intuitive. You can add an item by selecting a day,
then clicking on the time period in the left pane.
Even if you enter the beginning time as the half
hour, the planner enters the item as beginning on
the hour. Once an item has been added, it cannot be
edited or deleted, except in the To­do list Summary
area. Also, there are no alarms or notifications given
when an item is due. You have to open the planner
application to scan the entered items.

The contacts list is a standalone application. None of
the contact information can be shared with other
applications, making its use somewhat limited. I
should also add that both the Personal Information
Manager applications look outdated, as if they were
designed with GTK version 1.

Gnome 2.32: 4 Miscellaneous Desktop Apps
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by Jim Wilkinson (jimwilk)

The screensaver in KDE has a shortest time of 1
minute. But this can be altered down to 0 seconds if
that appeals. First, using Dolphin or Konqueror as
Super User, go to /usr/share and create a new folder
there called svr.

Next, find a suitable photo from your collection and
save it in /usr/share/svr as saver.png (for example)

Now, we can setup the screen saver to use this
photo. From Configure your Desktop, click on
Display and Monitor in Row 4.

Click on Screen Saver:

Notice that I use Slide Show under Banners and
Pictures. Press Setup.

Under Setup, I use Image Folder as /usr/share/svr.
Note too that I have turned off Show Names etc. and
set the delay to its highest value 140 seconds. There
is the photo of our outside seating area that I had
stored there as saver.png.
Now, to have some fun with the delay, using
Konqueror or Dolphin Super User, go to /home/jim/

With hidden files checked, find the folder .kde4 and
click on it. Next click on share and then config.

Find the file labeled kscreensaverrc and right click
on it. Open it with Kwrite:
You will notice that I have set the Timeout=0. That
will give a delay of 0 seconds. Set whatever Timeout
value that you want.

Fun With KDE Screen Saver
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Change Enabled=false to Enabled=true and save
the file.
When you are tired of having the screensaver
interrupting your work, go to Configure Your Desktop
and turn off the screensaver. Have fun – even play
some tricks on other users of your machine.

Screenshot ShowcaseScreenshot Showcase

Posted by Hootiegibbon, April 25, 2012, running KDE4.

Fun With KDE Screen Saver

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

The place where breaking news,
BitTorrent and copyright collide

http://www.linuxquestions.org
mailto:pclinuxos.mag@gmail.com
http://www.linfx.com
http://torrentfreak.com/
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by Darrel Johnston (djohnston)

GnomeBaker
Described as GnomeBaker CD/DVD Writer in the
menu, it can be found in the Archiving section. It is
usually the default optical disc burning application
for a Gnome desktop. The project page shows
version 0.6.4 as being the current one, last updated
on June 9th, 2011. This is the version in the
PCLinuxOS repositories.
After starting the application, you will see the default
window shown below.

The Edit pull down menu has only one option,
Preferences. It is here that you set the default
settings you want when you open the program.
These settings can be changed while performing an
operation. But, the program defaults won’t be
changed unless done from the Preferences window.

Under the General tab, you can choose a temporary
directory to use, and whether or not to clean the
directory upon exit of the program. You can also
choose to be notified when burning has completed,
and whether to display a progress bar or not.

Selecting the Devices tab shows the system’s
optical devices, and whether they are writable or
not. I found that you can manually check and
uncheck the Write CD­R, Write CD­RW, Write DVD­
R and Write DVD­RAM boxes, but it makes no
difference to the actual operability of the program or
the optical device being used. You can click the
Scan for devices button, and all appropriate write
options for a given device will be automatically

checked.
You can
manually
add a device
to the list
and always
scan for
devices at
program
startup.

Selecting the Advanced tab shows that the default
backend used for burning is wodim. I did not attempt
to add any other backends. You can also opt to
force recording and ignore directories too deep
warnings. I do not know if the latter option will
overcome some of the limitations of the
genisoimage CLI program.

Selecting the Tools dropdown menu from the
program’s main window shows all of the burning

options.
The Window dropdown
menu is shown below. Note
that if Show File Browser is
not selected, you won’t see
the Places and Name
sections in the program’s
main window.

Gnome 2.32: Two Optical Burners

http://sourceforge.net/projects/gnomebaker/


PCLinuxOS Magazine Page 11

I chose to erase the contents of a
rewritable CD. 4X was chosen by

default, which was the speed the disc was last
written at.
Selecting the Speed pulldown menu shows all
possible speeds available on the burning device
(above left).
The window below shows the CD being erased.
After the operation completed, I was given a
message to respond to and then returned to the
main program window.

From the main window, I next clicked the Data CD
button. In the Contents section, double­click
“GnomeBaker data disk” and enter a new name to
change the volume label of the CD or DVD. I

changed it to “TestRun”. You can simply drag and
drop files and folders from the file browser section to
the contents section to have them included. Used
and remaining space is displayed. Once your
selections are complete, click the Burn button.
You can elect to write the contents to an image file
instead of an optical disc. For some reason, the
previously entered volume name is not carried over

to an image file
as it is to a disc.
So, change the
name of the
image’s iso file
in the next
window from
“gnomebaker.is
o” to whatever
is desired.
I have found
GnomeBaker to
be feature
complete. It
may not have

all the bells and whistles of K3B, but it is adequate
for almost any optical burning task.

Brasero
Described as Brasero Disc Burner in the menu, it
can also be found in the Archiving section.
According to the project page, the latest stable
version is 3.0.0, dated April 5th, 2011. But, browsing
the archive at
ftp://ftp.gnome.org/pub/GNOME/sources/brasero/,
we see that the latest version in the directory tree is
3.4.1, released on April 16th, 2012. The version in
the PCLinuxOS repositories is 2.32.1. Shown below
is the main window that is displayed when the
program is launched.

The functions contained within the program are
handled by plugins. The plugins window is shown
below. Notice that one of the plugins is grayed out,
or “ghosted”.
In fact, only the first four plugins listed can be
selected in order to activate or deactivate it or
configure the options for that plugin. Reading the
package’s document file at /usr/share/doc/brasero­
2.32.1/README, we see this:

Gnome 2.32: Two Optical Burners

ftp://ftp.gnome.org/pub/GNOME/sources/brasero/
http://projects.gnome.org/brasero/
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Notes on plugins for advanced users
1. configuration
From the UI you can only configure (choose to use
or not to use mostly) non essential plugins; that is all
those that don't burn, blank, or image.
If you really want to choose which of the latters you
want brasero to use, one simple solution is to
remove the offending plugin from brasero plugin
directory ("install_path"/lib/brasero/plugins/) if you're
sure that you won't want to use it.
You can also set priorities between plugins. They all
have a hardcoded priority that can be overridden
through Gconf. Each plugin has a key in
"/apps/brasero/config/priority".
If you set this key to ­1 this turns off the plugin. If you
set this key to 0 this leaves the internal hardcoded
priority ­ the default that basically lets brasero decide
what's best.
If you set this key to more than 0 then that priority
will become the one of the plugin ­ the higher, the
more it has chance to be picked up.

2. additional note
Some plugins have overlapping functionalities (i.e.
libburn/wodim/cdrecord/growisofs,
mkisofs/libisofs/genisoimage); but they don't always
do the same things or sometimes they don't do it in
the same way. Some plugins have a "speciality"
where they are the best. That's why it's usually good
to have them all around

As examples, from my experience:
­ growisofs is good at handling DVD+RW and DVD­
RW restricted overwrite
­ cdrdao is best for on the fly CD copying
­ libburn returns a progress when it blanks/formats
That is a very imprecise way to handle program
functions to me. The best way to handle program
plugins would be to include a plugin manager that
either enables or disables them. The installation
path for the plugins is /usr/lib/brasero/plugins/.
Asking a user to remove unwanted plugins by
deleting files in the system area is asking too much.
Suppose the user decides s/he wants that function
later on? Reinstall the program?
While browsing the plugin list, I noticed many items
did not show a check mark as being enabled. The
first was cdrdao, used for copying, burning and
blanking CDs. That function should be enabled by
default. I opened Synaptic, installed the cdrdao
package and restarted Brasero. The cdrdao plugin
was then enabled, but still grayed out. The
dvdauthor plugin was disabled, which is used for
creating disc images suitable for video DVDs.
Installing the dvdauthor package from Synaptic
enabled the plugin. The libdvdcss2 package was
also installed to enable the dvdcss plugin. That one
is understandable, as the package is considered to
be illegal in some countries.

Going further, the dvd­rw­format plugin was
disabled. Installing the dvd+rw­tools package
enabled it. The transcode2vob plugin shows that
“mplex” GStreamer plugin could not be found. In an
attempt to enable the plugin, I installed the
gstreamer0.10­a52dec and gstreamer0.10­dv
packages, but to no avail. The transcode2vob plugin
is inoperable, although the /usr/lib/brasero/plugins/
directory contains both libbrasero­transcode.so and
libbrasero­vob.so files. The vcdimager plugin states
that “vcdimager” could not be found in the path. Yet,
the file libbrasero­vcdimager.so exists in the
/usr/lib/brasero/plugins/ directory.
Even more puzzling are these three plugins, not
enabled:
cdrecord ­ burns, blanks and formats CDs and DVDs
mkisofs ­ creates disc images from a selection of
files
readcd ­ copies any optical disc to a disk image
Not only should all three of those plugins be enabled
by default, each one is listed as a symbolic link
pointing to another program. Well, the binary
executable programs all exist in the /usr/bin
directory, named cdrecord, mkisofs and readcd, the
exact same names as the plugins. Not only that, the
files libbrasero­cdrecord.so, libbrasero­mkisofs.so
and libbrasero­readcd.so exist in the
/usr/lib/brasero/plugins/ directory. If anything, those
plugins should have double functionality, not none at
all.
In searching the internet for information on the
Brasero plugins, I found quite a few user posts
echoing the lack of usability, some as late as May of
last year. I suspect that having a newer version of
the program in our repositories would not add much
functionality, if any at all.
Of the plugins that are enabled by default, and not
ghosted, Normalization should not be on by default.

Gnome 2.32: Two Optical Burners



PCLinuxOS Magazine Page 13

Imagine that you are creating an audio disc with a
recording of Ravel’s Bolero on it. The exceedingly
soft passages at the beginning would be enhanced
and made louder. The thundering crescendos at the
end would be watered down in volume. You’d be left
with a recording that would not display the extreme
dynamic range of volume in the concert that Ravel
originally intended. For me, that would be extremely
disappointing.
It is my opinion that the program should be
completely revamped. A working plugin manager
should be used to handle the program’s functions.
That, or package it with dependencies on the
backend binaries to be used, and include softlinks to
any external binary executables needed. There’s no
need to reinvent the wheel. Just make one that rolls
efficiently. Brasero’s usability and functionality
cannot hold a candle to GnomeBaker’s.

Screenshot ShowcaseScreenshot Showcase
LinPC.us

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE! Posted by cstrike77, April 1, 2012, running Xfce.

Gnome 2.32: Two Optical Burners

http://www.linpc.us
http://www.pclinuxos.com/?page_id=10
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emailing of all the cartoons. He
sends me a multipage tiff file.
That is, it's a single tiff file with
multiple cartoon images inside.
Gimp can open this kind of tiff
file quite easily. When first
opening the file, Gimp instantly
knows it's a multipage tiff file.
Gimp then presents you with a
dialog window with a couple of
options. You can select all or
just a few of the images. In
addition, you can then open
each of the images as individual
files or as layers in a single file
in Gimp. I always open the
images as individual files. I
check the art and do just a bit of
editing, if needed (straightening,
aligning, etc.) And Gimp does
all this with equal ease. I re­
pack as individual files in one
folder and then zip it all up.
Because, not everyone runs
Gimp. And if non gimp users
come across a multipage tiff file,
they may not have the proper
software to open it.

Mark's Quick Gimp Tip

­Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

I distribute my cartoon features
through georgetoon.com I also
distribute the cartoons of Polly
Keener. (To see some of Polly's
cartoon work, visit
www.georgetoon.com/georgetoonfeatures.)
Polly's husband Bob does the scanning and

Answers on Page 32

Mark's Quick Gimp Tip & Double Take

www.gimp.org
www.georgetoon.com/georgetoonfeatures
www.gimp.org
www.georgetoon.com
www.georgetoon.com/blog
mailto:georgetoon@gmail.com
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Forum voted Sproggy mostlikely to have a long safe life

SNAKE STEW
Dice vegetables and put in pot.
Capture snake of your choice. Remove
head, skin and organs. Dice meat and
add to pot. Cover with water. Season
to taste and bring to boil. Simmer for 5
to 10 minutes. Serve.
Boa or python can also be served as a
raw appetizer.

Sproggy's entry for theForum Foibles CookbookKori von Sproggy

Sproggy designsa strange new phoenix
Sproggy as seen byHootiegibbon

"I SHOUT AS YOU IS GETTIN OLD" Sproggy to the Forum

Forum Foibles:Featuring Fabulous Foibler Sproggy
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by AndrzejL

I was trying to fix an NTFS partition on a USB disk
for a Friend of mine. I don’t have Microsoft Windows
installed on any of my machines SO I couldn’t use
chkdsk command. No problem. I have a PCLinuxOS
– one mean green heckuva machine.
I remembered that the Old­Polack was
recommending
fsck ­f /dev/sdxy
command to be run as root on unmounted partition
when booting from LiveCD.
I won’t bother booting into the LiveCD as it’s not / or
/home partition that I am trying to fix, I thought. Ok,
so I unmounted the drive using the KDE Device
Notifier and I ran the command:
fsck ­f /dev/sdb1
The outcome was not what I had expected it to be…

fsck from util­linux­ng 2.18
fsck: fsck.ntfs: not found
fsck: Error 2 while executing fsck.ntfs for/dev/sdb1

As it turns out – I am missing a package… but which
one? Synaptic package manager showed no entries
whatsoever. Rpmsearch was not very helpful
either… So I searched and searched and after a
while asked Cyryl for help. I was provided with
almost instant solution.

Make sure you have these packages installed:
A) ntfs­3g
B) ntfs­config
C) ntfsprogs
D) testdisk
and then run these two commands as root:
ln ­s /usr/bin/ntfsfix /usr/sbin/fsck.ntfs
ln ­s /usr/bin/ntfsfix /usr/sbin/fsck.ntfs­3g
Now try re­running the command but skip the ­f
parameter:
[root@wishmasbell andrzejl]# fsck /dev/sdb1
fsck from util­linux­ng 2.18
Mounting volume… OK

Processing of $MFT and $MFTMirr completedsuccessfully.
NTFS volume version is 3.1.
NTFS partition /dev/sdb1 was processedsuccessfully.
[root@wishmasbell andrzejl]#
I was not missing any packages. All I was missing
were two symlinks. The HDD was fixed as far as I
can tell.
Thanks again Cyryl.
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by Meemaw
The next financial program we will look at is Money
Manager EX. Their website is
http://www.codelathe.com/mmex/ and your
introduction to the program says:
“Money Manager Ex is a free, open­source, cross­
platform, easy­to­use personal finance software. It
primarily helps organize one's finances and keeps
track of where, when and how the money goes. It is
also a great tool to get a bird's eye view of your
financial worth.”
You will find a User Guide in 4 languages (English,
Italian, French, Russian) at
http://moneymanagerex.svn.sourceforge.net/viewvc/
moneymanagerex/trunk/mmex/doc/help/index.html
The first time you start MMEx, you will be asked to
create a new database or open an existing one.
Since you have none, you will have to create one.
Notice that you won’t get this window after the first
time unless you check the box at bottom left.

Clicking on Create a new database, you will see the
main screen with a blank section on the right. In
front of it, a Save dialog will open, asking you to
name your database. Then, a New Database Wizard
will open. You will see windows to set your currency
and a user name. The user name can be different
from your file name and is optional. The Add New

Account window will appear asking what the name
of the account is (they suggest the name of the
bank) and what type of account it is
(Checking/Savings, Investment or Term). Then an
account window will appear to let you put in more
details about the account you are creating.

You can edit the name of the
account, put in the account
number, contact information,
website and even notes about
the account. The only thing that
is required here is the Initial
Balance, but if you forget it,
you can right click the account
in the tree at the left and
choose Edit Account. You can
create your main accounts
now, and can always go back
and add other accounts later.
I added checking and savings
accounts first, and I can go
back at any time and add an
investment account.

Now the main screen looks like this:

Now we should start entering transactions. In the
tree on the left, click on the account you want to use.
You will get the following screen:

At the bottom of the window you will see three
buttons: New, Edit and Delete. Click on New to add
a new transaction. You will get the following window:

You need to choose the type of transaction:
Withdrawal, Deposit or Transfer. Most of the time
you will use Withdrawal and Deposit. To enter a
payment (withdrawal) you will need to put in the
check Number, Payee, Date, Category and Amount.

Linux Financial Apps: Money Manager EX
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You will have to add your own Payees, but you will
have a standard list of Categories to use. You can
always add more categories and payees with the
Organize Payees and Organize Categories dialogs
buttons in the toolbar.
If you need to do a Transfer, you will need to be in
the account from which you are transferring money.
Change the transaction type to Transfer and the
Advanced button will show up. Click on it and a pair
of different transactions windows will show. In the
first, you will need to designate how much you are
transferring, then click OK. Then the other window
will need to be completed with the account to which
the money is going, along with the date, category
and amount.

As you add transactions, your payee list will grow,
since you add every new payee yourself.
This program has a separate section for recurring
transactions, rather than making that section
obscure like in a couple of programs we’ve seen.
From the tree at the left of your window, click on
Repeating Transactions, and you’ll get another
window at right where you have Add, Edit, Delete,
Enter and Skip buttons at the bottom. Add, Edit and
Delete are the same as for the transaction screen.
When you add a transaction, you will get the add
screen and fill in the same information as for a

regular transaction, with the addition of the
frequency of the transaction and which account it is
to be used. You also have the option to have the
program add this to your designated account
automatically. If you don’t do that, the Enter and
Skip buttons in the main window make it possible for
you to place the transaction into your checkbook
when you want them there. You can also skip the
next occurrence if required. When you go back to
the main window, you will see the payee, account,
category and amount of the transaction, along with
the frequency of the transaction plus how long it is
until the next occurrence.

After you have your transactions entered, you can
look at reports. There are several reports already set
up in the program, so you may find the one you
need without trying to configure one yourself. Most
of the pre­configured reports have versions for
different time frames: this month, last month, last 30
days, this year and last year. You can do a report for
a specific category by using the transaction report.
When you click it, you will get a window which asks
you to specify the account you want to use, the
category and/or payee, and the time frame desired.
You will then get a list specific to those items, so if
you want to know how much you paid to your
landlord for rent last year, you can narrow your
transaction list to that specific information.

MoneyManagerEX also allows you to keep track of
not only financial assets, like bank accounts and
stocks, but it also has a section where you can list
your property assets, like cars and houses and
personal belongings. This may be a good place to
make a list of that coin collection or gun collection or
your valuable pieces of jewelry. Your Add window
will ask for the following: Name of Item, Date of
Purchase and Asset Type (this is a dropdown
containing Property, Automobile, Household Object,
Art, Jewelry, Cash or Other). In addition, you will
have to insert the Value, Change in Value (you
should designate whether each item appreciates,
depreciates or doesn’t change) and the percent of
change per year. You can also add notes to your
entry. Clicking OK takes you back to the summary
window where your item is listed. If you have had it
for a while, the appreciated or depreciated value is
already there.

Just as with one of our earlier programs, you can
keep track of your stock portfolio with this program.
Right­clicking on Stocks in the tree at left, choose
Add Account. Instead of a checking or savings, this
should be an investment account. You will again get
the New Account window where you can add other
information if you wish. Click on the new account

Linux Financial Apps: Money Manager EX
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you just created. I named mine Stock Portfolio. In
the window, you will get the buttons New, Edit,
Delete, Refresh and Settings. The Settings button is
used to designate the site you wish to use for your
prices. The program’s default setting is
finance.yahoo.com and asks you to designate when
the market opens and closes and how often it should
refresh your prices. Clicking New gives you the
smaller window shown, where you can add a new
stock acquisition. You need to enter the name of the
stock, plus the symbol used, the date you bought the
stock, the number of shares, and what you paid. You
will see a handy button which pulls up the stock’s
web page in the stock site you use. After you are
finished you can go back and Edit any of them if
you’ve made a mistake.

If you sell all of a stock, you can delete it. Using the
Refresh button will give you your current values.
This program works pretty well. I haven’t found any
idiosyncrasies that irritate me like I did in earlier
programs, and everything displays well.

Screenshot ShowcaseScreenshot Showcase

Posted by parnote, April 25, 2012, running Xfce.

Linux Financial Apps: Money Manager EX
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by Paul Arnote (parnote)

Just as with any major desktop environment
available for Linux, there will always be tasks and
settings that are not the easiest to accomplish or
change – or even find. This couldn’t be any more
true than it is with Gnome, since the Gnome
developers have this mindset that obscurity is a
good thing. Never fear – they have taken that
obscurity to a whole new level with Gnome 3.x.
Some obscurity is a good thing, since you don’t
want all these settings and tasks to get in the way of
the user actually being able to use their computer.
But taken too far (as many, including Linus Torvalds,
claim the Gnome developers have done), excessive
obscurity prevents the end user from performing
many critical and necessary tasks. I hope that these
tips, tricks and tweaks help lift the veil of obscurity
from Gnome 2.32.

De­skew Your Fonts

If your fonts are appearing rather skewed, it’s
actually quite easy to fix. First, right click your mouse
on an empty spot of your desktop window, and
select Change Desktop Background from the
context menu that appears.
Select the Fonts tab, then select the Details...
button.

At the top of this new window, set the resolution.
Typically, a resolution of 96 dpi works for most
people. If you select a lower resolution – say, 72 dpi
– then your text will appear larger. If you select a
higher resolution – say 120 dpi – your text will
appear smaller. Adjust this value until your text
appears as you like. Don’t worry if you mess things
up. You can always return this value back to 96 dpi
(provided you can still read the screen!).

While we’re talking about fonts, and while we’re
already in this window, you can also change
“Hinting” from “Full” to “Slight” to gain a slight speed
enhancement. I would not recommend turning
hinting off, since doing so may make your fonts look
fuzzy.

Speed Enhancement: Icons
There are many that criticize Gnome as being a
heavy, resource­hog desktop environment. If you
are trying to run Gnome on an older and/or slower
computer, you can help improve performance by
changing your icon theme.
Avoid using SVG icon themes. SVG icons are re­
rendered every time the icons are redrawn or
resized. Instead, use a PNG icon theme. If you find
a SVG icon theme that you just can’t live without,
convert the SVG icons to 128 x 128 PNG icons.

Speed Enhancement: Nautilus
There is no denying that Nautilus is an excellent and
powerful file manager. It’s the favorite of many Linux
users, in part due to how configurable and
extensible it is. However, on slower and older
computers, Nautilus can slow to a crawl. All of those
extra “bells and whistles” can cause a performance
hit.
Luckily, we can turn off – or seriously trim back –
most of those bells and whistles, and in the process,
make Nautilus much more responsive on slower and
older computers.
From Nautilus’ menu bar, choose Edit >
Preferences.

Gnome 2.32: Tips, Tricks & Tweaks
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Click on the Preview tab. Once there, you can make
some changes that will help improve the
responsiveness of Nautilus.
First, under Text Files, set “Show text in icons” to
Never. This will prevent Nautilus from scanning the
text to show a preview of the text file when you
hover your mouse over the icon.
Second, under Other Previewable Files, set the
“Only for files smaller than” setting to something less
than 100 MB, which is the default in PCLinuxOS
Zen. I recommend setting this to either 10 MB or 5
MB. Files larger than the limit will no longer display a
thumbnail depiction of the file, and will revert to
displaying a generic icon associated with that
particular file type. If you find that these reduced

settings still result in sluggish performance from
Nautilus, you can set the values to even lower file
sizes. You can also set “Show thumbnails” to Never.
This will cause Nautilus to never show thumbnail
representations of previewable file types.
Third, under Sound Files, you can set “Preview
sound files” to Never. This prevents Nautilus from
playing back sound files when you hover your
mouse over the sound file icon.
Fourth, under Folders, you can change “Count
number of items” to Never. This prevents Nautilus
from displaying the number of files in the current
folder in its status bar.

Speed Enhancement: Metacity
Gnome 2.32 uses the Metacity window manager.
You can lessen the impact of Metacity themes on
the resources of an older or slower computer by
selecting Metacity themes that use simple colors.
Using themes that use images will slow down
rendering, causing a potential performance issue
with older or slower computers.
While you’re at it, you can also turn off Metacity
animations. From a terminal session, enter the
following (all on one line):
gconftool­2 ­­type bool ­­set/apps/metacity/general/reduced_resourcestrue

Speed Enhancement: Gtk+ Themes & Wallpaper
Use Gtk+ themes that allow the user to change
colors. They are the simplest of all Gtk+ themes, and
thus consume the least amount of resources. For
wallpaper, use only wallpaper that uses “web safe”
colors, or solid colors. They are the ones that
consume the least amount of computer resources
when they are rendered.

Speed Enhancement: Startup Applications
Select System > Preferences > Startup Applications,
and the window below will be displayed.

There are quite a few applications that are started by
default in Gnome 2.32. However, there may be
applications that aren’t actually needed, and that
many people don’t use. Remove the check mark
next to those applications that you don’t need or
want to run when your computer starts up. Not only
will it help your Gnome session start faster, it will
also consume fewer precious resources on an older
or slower computer, since those applications won’t
be running in the background.
Also, so you can get to a working desktop faster,
you can select the “Options” tab and make sure that
the option to restart the applications from the
previous Gnome session are NOT automatically
started the next time you start up your computer.

Speed Enhancement: Compiz
Basically, turn it off. All of that eye candy comes with
a high price – a price that is exacted on your
computer’s resources. This includes processor
usage and memory usage. For some users, it boils

Gnome 2.32: Tips, Tricks & Tweaks
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down to whether to have a functional computer, or
one with flash and glitz. Personally, I choose
functional every time, over flash and glitz. The latter
is fine – if you have a computer that can handle it,
without having a noticeable effect on functionality.

Speed Enhancement: Replace Nautilus
While the added functionality of Nautilus is nice to
have, it does come at a price. Replace Nautilus with
PCManFM. You will save about 100 MB of memory
overhead by replacing Nautilus with PCManFM. The
choice of PCManFM is not only because it is a
lighter file manager, but also because once you get
rid of Nautilus, you will need something else to
manage the desktop – otherwise you won’t have any
way of managing the desktop. PCManFM has this
capability.
You don’t have to remove Nautilus from your
system. Just remove it as the default file manager
and desktop handler. First, enter the following in a
terminal session (all on one line):
gconftool­2 ­­type bool ­­set/apps/nautilus/preferences/show_desktopfalse
Don’t panic. The above setting will probably mess
your desktop up (removing icons and wallpaper),
since you just removed Nautilus’s ability to manage
the desktop.
Second, install PCManFM from Synaptic. Once
installed, launch it, and select Edit > Preferences
from the PCManFM.
Click on the “Desktop” tab, then check the boxes
next to “Manage the desktop and show file icons,”
“Show menus provided by WM when desktop is
clicked” and “Wallpaper.” Select your wallpaper by
clicking on the far right side of the “button,” and
select the “Mode” to use when displaying your

wallpaper. Select the “OK” button to save your
settings and exit the dialog box.

To make things easier, create a launcher on your
panel for PCManFM. Click on it whenever you have
work to do on files or you need a file manager.

Change Default Background Color
The default background color in Gnome is green.
This can be problematic if you are using a PNG file
with some transparent areas. Fortunately, this is
easy to change.
First, launch the gconf­editor from a terminal
session, by typing gconf­editor & at the command
line. This will launch the GUI version of gconf­editor.
Under PCLinuxOS, you do not have to be the root
user to use this utility.
Travel through the tree in the left pane to desktop >
gnome > background. Once you get there, you will
notice an appearance of the right pane that is a lot
like in the image below.

Note that the color designation (primary_color and
secondary_color) is a bit different than what you use
in Gimp or for the background color designation in a
web page. The first thing you will (should?) notice is
that the RGB color designation is twice as long as
you would normally expect. That is because the
typical color designation repeats for each color. So,
the #6666baba0000 green color designation
translates into #66ba00 in Gimp or HTML color
code.
Say you wanted to change the background color
from the default green to orange. Opening up Gimp,
we see that the color designation for orange is
#ffaa00, in hexidecimal. In gconf­editor, it becomes
#ffffaaaa0000. Notice how we double entered the
typical RGB values. Thus, the ff designation for the
red color channel in Gimp becomes ffff in gconf­
editor. Similarly, the aa designation for the green
color channel in Gimp becomes the aaaa. The 00
designation for the blue color channel in Gimp
becomes 0000.
Clicking on any of the values in the right pane will
display a brief explanation of the expected values in
the lower right portion of the screen. Feel free to
experiment with the values. If you do, I recommend

Gnome 2.32: Tips, Tricks & Tweaks
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writing down the default values – just in case you
mess things up and want to return things to their
default values.
There are some transparent PNG wallpaper files in
the default installation of PCLinuxOS Zen. Changing
the background colors, as well as the
color_shading_type, will alter how the background
appears when you use them.
Of course, you can also control most of this by right
clicking on an empty spot on your Gnome desktop,
and selecting Change Desktop Background from the
context menu that appears.

Clean Up Your Desktop
There are many users who don’t like to have a lot of
icons on their desktop. It reminds them too much of
Windows, where every application you install wants
to put its icon on your desktop.
Fortunately, with Gnome’s gconf­editor, it’s easy to
clean it up in a manner that is easily reversible at
any time. From a terminal session, type gconf­
editor & at the command line. When the gconf­
editor window appears, go to apps > nautilus >
desktop in the left pane. In the right pane, uncheck
the icons you wish to clear from your desktop. They
should disappear immediately.
Similarly, if you are a user who actually likes a
gazillion icons on your desktop, you can add any
that are listed by making sure the icons are checked.

Gnome Power Manager
If you are running Gnome 2.32 on a notebook
computer, you will want to install the Gnome Power
Manager, since it’s not installed by default. With
Gnome Power Manager, you can keep close tabs on
the state of your battery. Gnome Power Manager will
also control when you receive warning messages

about a low battery and a critically low battery. It will
also automatically take the assigned action (power
down, suspend or hibernate) when your battery
reaches the defined low level.

New Places – The Easy Way
One of the default menus in the standard Gnome
menu is the “Places” menu. When browsing around,
looking for ideas for the Gnome desktop article
series, I came across multiple users complaining
about how “difficult” it was to add new folders to the
“Places” menu.

It’s actually much easier than these users were
making it out to be. To add items to your “Places”
menu, simply click and drag a folder from the right
pane of Nautilus to the bottom left pane in Nautilus.
Voila! There it is. You can organize them by
dragging them to their new position within the list.

Summary
I’m sure there are many more tips, tricks and
tweaks. I’ve tried to include the ones I thought would
be the most useful to the most number of people.
Particularly, the speed enhancement tips, when
applied, make Gnome as nimble and quick as the
lighter Xfce desktop. Gnome is a very robust
desktop environment, and it has a lot of fans,
despite the obscurity built into it by the Gnome
developers.

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

Gnome 2.32: Tips, Tricks & Tweaks
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by Chuck Rice (Ramchu)

Here we will explore some methods to customize the
Firefox Web Browser.
Open Firefox.
Let’s start with the Toolbars. Don't like the location of
the buttons (ie: forward, back, home, refresh, etc.)?
Just go to View and click on it, go to Toolbars and
slide across and down to Customize and left click on
it (Customize). If the window that pops up is covering
some of the buttons, just left click at the top of that
window and drag it to a location that you are
comfortable with.

Now you can left click and hold then drag and drop
the buttons that you wish to move to your desired

location in line with the Address bar. In the
Customize window that popped up, let’s say that you
want to add a printer button. Left click on the printer
icon in that window and drag and drop it along side
the other buttons that you have moved. When you
are satisfied, just close the customize window and
you are done.
Don't like Tabs on top? Just click on View > Toolbars
> and remove the tick beside ‘Tabs on Top.’
Don't like the Bookmarks Toolbar below the Address
Bar? Go back to View and go to ToolBars, slide your
pointer across and down to Bookmarks Toolbar and
left click to remove the tick and instantly the
Bookmarks Toolbar is gone. Don't worry, it is just as
easily restored by adding the tick back.
If you would like to add a Bookmark to the Bookmark
Toolbar, just go to the site that you would like to
Bookmark, and at the left end of the Address Bar,
left click on the Icon and drag and drop it onto the
Bookmarks toolbar. If for some reason you wish to
remove the Bookmark from the Bookmarks toolbar,
then just right click on it and click delete.
Is the Toolbar area at the top of Firefox dull/drab or
just not to your liking? Just click on Tools > Add­Ons
> Get Add­ons and look for Personas. When you
find a Persona that is to your liking, just add it to
Firefox. If you like, there is a tutorial on the Mozilla
website that will tell you how to create your own
Persona.

There are also Extensions that you can add to
Firefox for security, advertisement blocking, or video
downloading from sites like YouTube. Again, open
Firefox and go to tools > Add­ons > Get Add­ons.
Type in the search box at the upper right the type of
add on that you want to add to Firefox. I use No­
Script, AdBlock Plus, Flash and Video Downloader.
Next, let’s say that you want to change your
homepage. At the top of Firefox, click on Edit, then
click on Preferences. In the pop up window, click on
the General tab at the top then look for Home Page
and you can change it there.
In the Preferences window, you can also change
where Firefox saves your downloaded files from the
internet. The default setting saves files to the

Customizing Firefox Web Browser
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Downloads folder but you can click on the browse
button and choose a different location.
When clicking on the Tabs Icon at the top, it will
open another page and allow you to set how Firefox
handles Tabs in your Browser.
The Preferences window has several other tabs.
The Content Tab:
By clicking on the Content Icon, you can set whether
or not to block pop up windows and create an
exceptions list. You can also change how Firefox
handles images, enable and/or disable JavaScript in
Firefox, and finally you can also select your desired
font for Firefox.
The Applications Tab:
By clicking on the Applications Tab, you are able to
select which application is started for a certain
media. For example, maybe you are wanting to view
a Windows Media Video and you would prefer to use
Clementine, instead of the Windows Media player
plugin. This is where it is set. Just click on Windows

Media Video and then click on the drop down at the
right and select how it is handled.
The Privacy Tab:
Under the Privacy tab you can have Firefox tell Web
Sites that you do not want to be tracked.
This is also the place where you tell Firefox how to
handle your browsing history, and also the place to
remove your history and/or cookies.
The Security Tab:
Clicking on the Security tab allows you to be:
warned when sites try to install add­ons, block
reported attack sites, block reported web forgeries,
and it is also the place where Firefox handles
Passwords.
The Sync Tab:
This is where you set up Firefox Sync to be able to
access your History, Bookmarks, Passwords and
open tabs across all of your devices.
The Advanced Tab:
This is where you can decide how Firefox connects
to the Internet, the encryption that Firefox uses and
other useful features.

Summary
These are the very reasons that Firefox is so
immensely popular among web users. Its capabilities
can easily be extended and tailored, its interface can
be customized, and it goes a long way to insuring
that our web experience is safe, yet unique for each
user. In a lot of ways, Firefox can be whatever you
want it to be.

Support PCLinuxOS! Get Your Official
PCLinuxOS
Merchandise Today!
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by Peter Kelly (critter)

Introduction
The dd command is one of the oldest Unix
commands. The name means data duplicator but is
sometimes referred to as data destroyer due to its
practice of doing exactly what it is told, which is not
necessarily what the user intended. The dd
command is very efficient but care must be taken
when using it, especially when issuing the command
with superuser privileges.
The command takes a stream of data as its input,
optionally applies certain rules and conversions
during its passage and outputs it to a nominated
destination file/device. As long as everything is
going fine dd performs its task quietly and efficiently
outputting just a brief summary upon completion of
the task.
Three buffers are used to hold the data on its way
through the command, a read or input buffer, a
conversion buffer used when a conversion is
specified and an output or write buffer. This
configuration allows for considerable flexibility in
use. If the if option is not specified then STDIN is
used, this can be the output from another command
or even the keyboard. If of is not specified then
STDOUT is used which is usually the screen but it
may also be piped to another command. If all this
seems a bit mystical then the examples that follow
later should make this a little clearer.

Basic usage
Like so many Unix/Linux commands dd is designed
to process data flowing through it in a continuous
stream however the format of its options are

somewhat unusual and take the form
{option}={value}.
The command
dd if=myfile of=outputfile
would simply make a copy of the file myfile named
outputfile. The option 'if' is used to define the input
data and the option 'of' to define the output. Other
options include 'bs' to define the size of blocks of
data to operate on and 'count' to tell the command
how many blocks of data to process. If these options
are omitted then the default block size of 512 bytes
is used and data is processed either continuously or
until either the end of the input data is reached or an
error occurs. There are many more options, as we
shall see, but these are the most common ones.
The danger in using this command carelessly is this:
if I wanted to make a copy of a disk to a new, empty
disk then I could use a command similar to the
following
dd if=/dev/sda of=/dev/sdb bs=4096
However, If I were to mix up the drive names, then
instead of copying the existing data to the empty
drive I would copy the empty sectors of the new
drive to the older one, overwriting the data and finish
with two empty drives. Caution is paramount and
you may want to do a test run, omitting the output
destination similar to the following example using a
file named testfile that I created for the example.
With no of= in the command the contents of the file
are echoed to the screen.
dd if=testfile
this is a file to test the output from the dd
command

0+1 records in
0+1 records out
55 bytes (55 B) copied, 0.000234282 s, 235 kB/s
If the input file is large, say a hard drive or partition,
then you can limit the test output by using a smaller
block size and a count of 1 block. Proceed only
when you are confident.

Applications
So what can we use it for? The dd command is
extremely versatile and is probably best
demonstrated with some examples. The following
demonstrate some of the power of the command.
Here is a simple one to start with. Create a text file.
Simply pass the name of the file to create and then
start typing. To close the file, type Control+D and
you're done.
user@home# dd of=testfile
This file was created to demonstrate the use of
the dd command.
You may enter as much text as you like or just
make quick note.
0+2 records in
0+1 records out
128 bytes (128 B) copied, 119.878 s, 0.0 kB/s
user@home cat testfile
This file was created to demonstrate the use of
the dd command.
You may enter as much text as you like or just
make quick note.
Here the block size (bs) was not specified, so the
default size of 512 bytes was used. The summary
shows how many full and partial records were
processed. The input records are lines and there are

Command Your Disks With dd
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2 of them, each partial (less than the 512 byte block
size). Only one record was written, and this was also
less than 512 bytes.
To make an exact copy of a hard drive use the
command like this:
dd if=/dev/sda of=/dev/sdb bs=4096
conv=notrunc,noerror
Here we use a block size of 4KB but
experimentation with this value may may provide
better results, depending on your system. Two
conversion options have been added. Without the
first, notrunc, target drive would be truncated to the
size of the input drive, which is usually undesirable.
The noerror option tells dd to carry on if a read error
is encountered.
Before an old drive is discarded it is a good idea to
'wipe' it clean and dd is ideal for this.
dd if=/dev/zero of=/dev/sdb1 bs=1M
dd if=/dev/urandom of=/dev/sdb1
The first method fills the drive with zeroes,
overwriting any data. The second method fills it with
random data but is slower. Most modern systems
should be able to handle a block size of 1MB.
If we use the zeroing method then it is a simple
matter to check that no readable data remains.
dd if=/dev/sdb1
As no output file is specified it goes to STDOUT, the
screen. This works in a similar way to the cat
command, but is more efficient.
If you want make a backup of a cd to an image file
on your hard drive use
dd if=/dev/sr0 of=/home/user/mycd.iso bs=2048
conv=sync,notrunc

Change /dev/sr0 to whatever your cd drive is seen
as. CDs have a block size of 2048 bytes so this is
the size used here. The image can be mounted with
a command such as
mount ­o loop /home/user/mycd.iso /mnt/mycd
When you can't remember how to get a command to
do something and the help is minimal or is really
heavy going, you can sometimes get a hint by
looking for human­readable text embedded in the
file. The strings command can be utilised here.
user@home# dd if=/bin/ls | strings | grep ­a
reverse
219+1 records in
219+1 records out
112408 bytes (112 kB) copied, 0.00361762 s, 31.1
MB/s
­r, ­­reverse reverse order while sorting
Reverse
Need to increase your swap space? Make a swapfile
with dd:
dd if=/dev/zero of=/swapspace bs=4k
count=250000
mkswap /swapspace
swapon /swapspace
A RAM drive can help speed up operations that
require a lot of disk access. You can easily create
one or several with dd.
dd if=/dev/zero of=/dev/ram7 bs=1k count=16384
mke2fs ­m0 /dev/ram7 4096
Test it:
hdparm ­t /dev/ram7
/dev/ram7:
Timing buffered disk reads: 16 MB in 0.02
seconds = 913.92 MB/sec

Mount it:
mkdir /mnt/mem
mount /dev/ram7 /mnt/mem
If you want to duplicate a hard drive partition to use
as a backup (in case of disaster), then we need to
add a few more options
dd if=/dev/sda2 of=/dev/sdb2 bs=4096
conv=notrunc,noerror
Here, the input is the partition we want to clone, the
output is where we want it to go and must obviously
be at least as big as the input partition. Do not mix
these two up. Next we specify a block size of 4096,
which is 8 sectors of 512 bytes and is a good
optimum size for this operation. Finally, we specify a
couple of conversion options – notrunc and noerror.
It is usually a good idea to run the fsck command on
the new partition before you use it.
Convert a text file to uppercase:
dd if=filename of=new_filename conv=ucase (or
lcase)
Benchmark a drive:
dd if=/dev/zero bs=1024 count=1000000
of=/home/me/1Gb.file (write)
dd if=/home/me/1Gb.file bs=64k | dd of=/dev/null
(read)
Feel free to play around with bs and file size.

Watching the progress
Many of the operations that dd is used for, such as
cloning a partition, are quite lengthy and dd is very
secretive, showing no output. How do you know then
that the process is actually running and not just
locked up or stopped? There are a couple of ways to
approach this.

Command Your Disks With dd
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The first way is to pass the process the USR1 signal.
Usually, we pass a signal to a process to terminate
or kill it, but the dd command was written to do
something special when it receives this signal. It
temporarily stops processing data and outputs some
statistics to Standard Error, usually the screen, and
then resumes its task. To make use of this, we have
to catch the process identification number (PID) and
run dd in the background. If we then send this signal
to the PID, we shall see where dd is up to. This is
easier than it sounds. Here, I am creating a 1 GB file
of random data. The PID is to be found in the $!
shell variable.
user@home $ dd if=/dev/urandom of=testfile
bs=4k count=256000 & pid=$!
[2] 3106
[1] Exit 1 dd if=/dev/urandom of=testfile bs=4k
count=256000 pid=$!
user@home $ kill ­s USR1 $pid
28057+0 records in
28056+0 records out
114917376 bytes (115 MB) copied, 12.4044 s, 9.3
MB/s
user@home $ kill ­s USR1 $pid
72844+0 records in
72843+0 records out
298364928 bytes (298 MB) copied, 32.2774 s, 9.2
MB/s
user@home $ kill ­s USR1 $pid
155666+0 records in
155665+0 records out
637603840 bytes (638 MB) copied, 69.0612 s, 9.2
MB/s
user@home $
256000+0 records in
256000+0 records out
1048576000 bytes (1.0 GB) copied, 113.598 s, 9.2
MB/s

Another way to achieve this, which I think is a more
elegant solution, is to use the pv command, which
you will have to install from the repositories. The
input file is piped into the dd command using the pv
command. The options I have passed to pv are:
­p show a progress bar
­e show the estimated time to completion
­s 1000m tells pv the size of the file I am transferring
(This is used by ­e).
pv ­pe ­s 1000m /dev/urandom | dd of=testfile
bs=4k count=256000
Partial output ­
[======================> ] 31% ETA 0:01:19
Final Output ­
256000+0 records in
256000+0 records out
1048576000 bytes (1.0 GB) copied, 115.727 s, 9.1
MB/s
[=======================================
=============================>] 100%

Summary
The dd command is a very useful tool to have
around, and it is worth the effort to learn at least the
basics. It should however be used with a little
caution when transferring valuable data. There are
times when a simple copy (cp) will do the job, and
other times when a command such as rsync would
be more appropriate. However, the usefulness of dd
cannot be denied. Unrestricted by file structures or
block sizes, for raw data transfer, dd is limited only
by your imagination.

Visit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclinuxos­mag"
(without the quotes)
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Connect connections in one
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by Old­Polack

There has been some confusion about sudo support
on PCLinuxOS. Hopefully, this will clarify the subject.

In The Manner Of The Buntus = ITMOTB
Sudo is just another Linux tool, but one that when
abused, can drastically impair the security of one’s
system. All the major Linux releases, except the
buntus and their clones, agree that when used
ITMOTB, sudo is a major security risk, so none of
them, by default, implement it ITMOTB. Our policy
has also always been to not support the use of sudo
ITMOTB, and we have never varied on that. When
we say we discourage the use of sudo, ITMOTB, we
say it with extreme prejudice.
We have always supported the proper use of sudo
as a limiting resource, when root privileges are
needed for a specific repeatable purpose, such as
when needed for the proper functioning of an
application, within a script, or when a specific user
on a multi user system is assigned limited
administrative duties, but is not allowed access to
the root password or full root privileges. This is the
purpose for which sudo was intended.
When implementing sudo, care should be taken to
limit a user’s entry in /etc/sudoers to the absolute
minimum of specific commands needed to perform
the task at hand.
Sudo, when used ITMOTB, gives blanket, unlimited
root privileges to a normal user, who can then
literally run as root using his own normal user's
password; there being no specific root password set,
the normal user's password effectively becomes the

root password, thereby removing an entire layer of
Linux system security. (the separation of all normal
users from the root user) This is the abuse of sudo
we speak of. We feel that it is totally irresponsible,
and it is that which we refuse to support.

If someone comes here, refuses to learn to run
PCLinuxOS as it was designed to be used, with a
proper root password, su and su ­ commands to
grant root permissions, while demanding instructions
to run their system ITMOTB, we respectfully suggest
they install a buntu version instead, or one of their
clones. We will not officially condone this deliberate
breach of security protocols, and will not tolerate
having instructions to facilitate the use of sudo
ITMOTB on this forum. On this point, we are
adamant, and this decision is not open to debate.
Any tool can be misused, and we cannot prevent
any individual from abusing their own system. What

we can do is prevent the aiding and abetting of that
misuse/abuse on this forum, where unwary and
inexperienced new users could be exposed to it, and
think we condone and support such abuse. We do
not!
Within the framework spelled out above, we have no
problem with anyone posting proper instructions to
those seeking to use sudo in the responsible
manner for which it was intended. Those that can't
refrain from posting instructions to use sudo
ITMOTB will be subject to post deletion, reprimand,
and possible cancellation of their posting privileges
on this forum.

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

Why PCLinuxOS Shuns sudo Use
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by Gary L. Ratliff, Sr. (eronstuc)

The beginning of the story
Several weeks ago I submitted a story on how I was
now able to talk to my computer to enter my articles
instead of typing in the material. This concentrated
on my recent purchase of the Dragon Naturally
Speaking (DNS) Basics 11 version at the local
Walmart for the low price of $50. Now upon reading
the user guide which came with the product, I
learned that the product was for one person and
could be installed upon more than one computer,
provided that one user was the only one using it. So
you could do work at the office on the computer
there, and then bring work home and use their
computer there.
Next the Editor told me this was a Linux publication
and challenged me to get it to run on Linux. Being a
Windows application, this would require installing it
using Wine or some other product which would run
Windows applications. I learned that my system had
version 1.2 of Wine installed, and my attempt to
install DNS using this version failed. So off I went to
Wine HQ to learn if there were more recent versions
which might function with DNS. Here I learned that
Crossover, a product of Code Weavers, was the
major sponsor of the Wine project and had made
major contributions since Corel abandoned the Linux
ship.

The Trial with Crossover
I downloaded Crossover by obtaining install­
crossover­11.0.2.bin and installing it, following the
instructions. Indeed, this installed and ran DNS11
perfectly. However, it is a commercial product and

requires purchasing a license to use it beyond the
trial period. Also, it is installed from outside the
repos, so back to Wine I went. The only one I have
on my system is version 1.2. Again I visit Wine Hq
and download wine version 1.5.2 and run the
configure and make commands. However, this did
not give me a wineconsole command to allow
reaching my DVD drive, which had the program’s
install DVD. A trip to Synaptic shows more recent
versions of Wine but they will not install. So I
changed my repository.
Editor’s Note: be sure to never have more than one repo
selected in Synaptic (excluding the special “megagames”
repository), since the mirrors all contain the same data
but are synchronized at different times.
Once I reloaded, I learned that version 1.4 of Wine
was available. So, I installed Wine and Winetricks.
Now I was ready to learn if Wine 1.4 could install
DNS11.

I reached the wineconsole by giving the command
‘wineconsole cmd.’ Shortly after, an E: prompt was

presented. You will need to learn where the system
thinks your DVD drive is. By working through the
alphabet, I learned that my system had the program
files on drive J. So, I used the dir command to get a
list of the files, and began the installation by giving
the command ‘setup.exe’. As you can see from the
screenshots, the first item to install is the required
Visual C++ 9.005 runtime. Once this has been
accomplished, the install shield begins to install the
system files.

You simply click a series of next buttons while the
product is installed to your “C:” drive. You will be
asked for your name and the serial number of your
product. When the product is installed, you will know
it has completed when you see the “Finish” button.
Note that you will almost always want to use a
typical install for your system (first screenshot, next
page).
As you can see, the program is now installed. The
next task is to setup your microphone and sound
system to work with the product. The system is

Run Dragon Naturally Speaking Under Wine
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trained to the speaking of your voice. This is
accomplished by reading various text passages for
about 5 minutes, and then your user profile is
created.
Once the profile is created, you are ready to launch
the product. You should find that your start menu
now contains an entry for Wine and there will also
be a sub­menu for the various programs you install
to Wine. If this is your first Windows application
installed in Wine, there will only be the entry for
Dragon Naturally Speaking 11.

To dictate, you will need to either tap the + key on
the numeric keyboard, or click the mouse on the
microphone in the left corner of the Dragon toolbar.
If the mike is red and down, it is off. If the mike is
green and up, it indicates it is ready to accept
dictation.
A tutorial is included with the product, which should
guide you through the steps needed to become
proficient in its use. From the toolbar, you may select
from tools to load in the DragonPad, which will
provide a page into which you may now dictate as
shown in the following screenshot:

Now that you have a working system, you most likely
will want to install other software to use with it, since
it will only function with other Windows software. I
had an old copy of Word 97 and installed this to my
new Wine area. Giving Dragon the command “Open
Word” did indeed launch this program. However, I
soon learned that this old system would type nary a
letter when you attempted to dictate to it.
The ability to write a document using Dragon and
similar products is provided by opening the Dictation
Box and speaking into it. Once you have the desired
text, you simply transfer it into your application by
clicking the transfer button.

Now that you have a system allowing you to produce
text on the screen by talking instead of typing, you
may want to get some other tools for this. Note that
trying to load Internet Explorer while in Linux is a no­
no, since Bill Gates’ product informs you that its
browser may only be used on Windows. Nor was the
attempt to download the Windows version any more
successful.
What you have to do is download the installer in
Windows, then exit to Linux and use your Linux file
manager to drag the installer into your system, and
then install it using Wine.
Now that you know how to use Linux and Wine, you
too can dictate your letters and other text
documents.

Answers to Mark Szorady's Double Take:
(1) Hair different; (2)Mouth different; (3) Shirt collar
missing; (4) Card in hnd smaller; (5) Shirt cuff
missing; (6) Keypad smaller; (7) Bush missing

Run Dragon Naturally Speaking Under Wine
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We who use
and love
PCLinuxOS
are in awe of
the guys
and gals
who give
their time
and talents
to make this
distro the
very best

There's a place my heroes go to gather
They meet there regardless of the weather

To the forum they go to mix and share their little tricks
All ties to Windows they did sever

To Linux they are faithful true forever
They're always working on creation

Finding new ways for innovation
Into files they go so deep no time they have to sleep

They never even take vacation

Saving the PC Nation again and again

Always at their station they know they will win

MP3 OGG

ms_meme's Nook:Heroes Of PCLinuxOS

http://pclosmag.com/html/Issues/201205/files/pclosmen.mp3
http://pclosmag.com/html/Issues/201205/files/pclosmen.ogg
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ms_meme's Nook: Heroes Of PCLinuxOS

HeroTexstar
Main Man ­ Main Plan

When his star was born
we were reborn into an

OS for the ages

HeroMeemaw
Scribus Scribbler

As Assistant Editor her
projects do not go

unnoticed

HeroNeal
Neal­the Real Deal

A Man among Bears
Solid Rock that fortifies

our OS foundation

Heroparnote
Magazine Mogul

He gives and gives
The Note PCLinuxOS

Magazine ain't gonna be
without

Heroold­polack Heropinoc HeroSproggy Herojaydot
Full Monty Maintainer
Libre Office Manager
We see what we like
We like what we see

Distro Driver­Packager
Phoenix maintainer
Whatever he does

he does well

AdministratorExtraordinaireWorking behind thescenes to make us thebest we can be

Administrator­Grub andFile System ExpertWorks day and night tohelp us all be betterPCLinuxOS users
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ms_meme's Nook: Heroes Of PCLinuxOS

HeroScoundre
Forum Administrator

Rules with his hammer
Not from Alabama

Herotimeth
PCLinuxOS

Design Studio
Bull Tamer
Bull Namer

HeroUCan2 Herodavecs
PCLinuxOS MailPCLinuxOS KnowledgeBaseThe Butcher The BakerThe Knowledge Maker

Forum Moderator
Upside down

but right on target

HeroHootieG HeroArchie HeroLeiche Heromelodie
Forum Administrator
Iced Latte maintainer
Shoots from the hip

Never a slip

Former Forum
Moderator

Packaging Power
from this Worthy

Scribe

Script AuthorPCLinuxOS LXDEmaintainerScripts and slips hemaintains so well

PCLinuxOS OpenboxmaintainerOpenbox is an openbook to her



PCLinuxOS Magazine Page 36

ms_meme's Nook: Heroes Of PCLinuxOS

Heroms_meme
Words on her fingers

Songs on her toes

HeroDragynn Heromenotu Heroioechimp
Zen

Zen and chickens
Has it both ways

Wealth of knowledge
A constant good read

Big Bag of Fur
Post Counter

Committed to our
PCLOS family

HerosiamerHeroLinuxera HeroJoble HeroRudge
Naughty_Boy slayer

Former Forum
Administrator
Creator of e17

Remasters

Zen
Hardware

and
Software
Does it all

Those he touched will
always remember

R.I.P.

He Drums He Cooks
He Has Jrex

Contributes Every Day
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ms_meme's Nook: Heroes Of PCLinuxOS

HeroJuniors
longtomjr sproggyjr
PCLinuxOS Kid's
Forum Founders

Gimp Inkscape Artists
The Future of Linux

Herodjohnston
Hardware
Software
Magazine

Does it all and well

HeroForum
PCLinuxOS heroes are many
They meet in the forum everyday
Giving help and aid to others
And it never is done halfway
Some always keep us updated
On the latest computer news
Others post all about bacon
Us they try to amuse
Our PCLinuxOS family is caring
Everyone there is a geek
They love the Linux System
Each member is special and unique
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by Paul Arnote (parnote)

Many users, like myself, use VirtualBox to run a
copy of another operating system on top of
PCLinuxOS. It may be Microsoft Windows. Or it may
be another Linux distro. Or, it may be one of the
“fringe” alternate operating systems that the
magazine’s Darrel Johnston has been writing about
for a while. Whichever the case, VirtualBox allows
users to run other operating systems from the
comfort and security of PCLinuxOS, without having
to reboot your computer. VirtualBox gives users
ultimate flexibility, as well as the chance to “play”
with other operating systems.

As I detailed in the February 2012 issue of The
PCLinuxOS Magazine, I recently built myself a new
desktop computer from scratch. On my previous
desktop computer, I was running a few different
installations of other operating systems in
VirtualBox. I didn’t want to lose those VirtualBox
installations, and I certainly didn’t want to have to
reinstall all of them from a raw start – and have to
apply all those updates. While the former usually

takes less than an hour, applying updates to
Windows installations can be an all day affair.
To avoid having to reinstall all of those different
Windows installations, I simply chose to move the
VirtualBox virtual hard drive files to my new
machine. To do this, I first had to find where
VirtualBox stored the virtual hard drive files.
Fortunately for me, I always pointed VirtualBox to
store them on my extra 320 GB drive, in the “vm”
folder. Since I had the most space available there, it
made sense to store the rather largish hard drive
images there. So, I backed up all the *.vdi files
stored in my “vm” folder to my 500 GB USB hard
drive, prior to switching my desktops around.
Before I go much further, there are a few different
ways to move VirtualBox virtual hard drive files. The
method I’m going to detail here is the one I’ve used,
and it has worked perfectly for me every time. Some
guides tell you to go into VirtualBox’s Virtual
Machine Manager and “release” the drive image
from VirtualBox – which makes sense if you are only
moving the virtual hard drive file and re­attaching it
to the same VirtualBox installation. Otherwise,
VirtualBox may nag you to death about not being
able to find one of its virtual hard drive files.
I’ve also seen other guides recommend that you go
into the snapshot settings for a virtual machine and
“merge” those snapshots into just one image. I have
to admit that I’ve never done this step, and my
virtual hard drive images, along with all of its
snapshots, have made the move without incident.
Above (top of next colum) is how my VirtualBox
window appears when I launch it (I’ve since gotten
rid of the WinXP_VM image, since it was BSOD’ing
me to death). When you highlight the selected virtual
machine, all sorts of useful information pops up on

the right side of the screen. As long as the virtual
machine isn’t running, you can change many of
those settings, including how much RAM and video
RAM you dedicate from your host system
(PCLinuxOS, in this case) for the virtual machine’s
use. Notice under the “Storage” category, the “IDE
Primary Master” file is called “WinXP­SP3.” That is
the filename – minus the path – for the virtual hard
drive file that VirtualBox is using for that particular
virtual machine.

Move VirtualBox Drives With Ease

http://pclosmag.com/html/Issues/201202
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Also stored on my 500 GB USB hard drive is a
virtual hard drive file for a three or four year old copy
of Linux Mint, with the KDE 3.5.8 desktop. For the
rest of this article, we’ll be walking through the
“resurrection” of that hard drive image in VirtualBox.
To get started, click on the “New” icon in the
VirtualBox toolbar.
This launches the “New Virtual Machine Wizard” in
VirtualBox. There’s not much to do here, other than
read, so let’s click next and move on to the next
screen.

In the next window, you give the name that you want
to be displayed in the list of your virtual machines in
VirtualBox. If not already automatically selected, you
will want to also select the Operating System type,
as well as the version. When I typed in Linux Mint,
VirtualBox recognized it and pre­selected “Linux”
and “Linux 2.6” for me. Once you’ve done these
steps, select the “Next” button to proceed to the next
screen.
Next, you have to tell VirtualBox how much of your
host’s memory you want to dedicate to running the
selected virtual machine. Despite having 8 GB of
RAM on my new desktop and running the 2.6.38.8­
pclos3.pae.bfs kernel, VirtualBox does not see all of
my RAM. So, I feel comfortable allocating ½ of the
“visible” RAM to running the three or four year old
version of Linux Mint in the virtual machine, since

PCLinuxOS is able to see all of my 8 GB of installed
RAM.

Now we need to tell VirtualBox where to find my
previous virtual hard disk file. You will notice that
“Start­up Disk” is checked. Right below it, your
options are to “Create new hard disk” and “Use
existing hard disk.” You would normally choose the
first option, if you were making a new installation.
However, we need to choose the second option.
Select the small folder icon to the right of the drop
down list box immediately below.
This will open up the typical “File Open” dialog box.
Choose the *.vdi file that represents the virtual hard
drive file you are wanting to import into VirtualBox. In
our case, we need to travel into the “Linux Mint”
folder, and select the Mint.vdi file. You’ll be returned
to the previous dialog box once you make your

selection. Click the “Next” button there to proceed
through the rest of the VirtualBox Wizard.

You’ll also notice that I keep “copies” of my virtual
hard drive files, just in case one of them becomes
corrupted. This is a lot easier to do when you have
literally tons of extra storage space. I don’t bother
running anti­virus software in my Windows
installations. If I pick up a virus, I simply delete the
virtual hard drive file and reinstall from the copy. Of
course, this only works if you are diligent about
making the copies – and keeping them current. I can
usually be back up and running from a clean
installation in the amount of time it takes me to copy
and rename the backup file – usually less than five
minutes.

Move VirtualBox Drives With Ease
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Your last window in the VirtualBox Wizard is the
“Summary” window. If you are satisfied with
everything that is detailed in the window, select the
“Create” button.

After creating your new VirtualBox virtual machine
(actually, we just imported an old *.vdi file), you’ll find
your old virtual machine now shows up in the list of
available virtual machines in VirtualBox. Of course,
it’s always wise to check to make sure that the
imported virtual machine runs as you expect.

Well, of course it does, as the Linux Mint window
above illustrates. Highlighting the Linux Mint virtual
machine in VirtualBox, then selecting the “Start” icon
on the VirtualBox toolbar launches the virtual
machine.

Summary
VirtualBox is an extremely handy tool for just about
any computer user – regardless of which operating

system they are using as a host. It allows you to try
out as many OS’s as you want, with the only
restriction being the available space on your hard
drive.
The method I detailed above has never failed me.
Moving to a new computer, and moving all of your
virtual machine hard drive files along with it, couldn’t
possibly be any easier.

Screenshot ShowcaseScreenshot Showcase

Posted by T6, April 2, 2012, running KDE4.

Move VirtualBox Drives With Ease
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by Paul Arnote (parnote)

As the magazine closes out coverage of Gnome
2.32, I’d like to leave you with some additional
resources that you can call upon to further expand
your knowledge. As you can imagine, since the
announcement of Gnome 3.x, most of the remaining
Gnome 2.32 documentation is found at the sites of
other Linux distros.
Before long, much of the Gnome 2.32
documentation may become difficult to find. Thus,
you may want to print out any of the Gnome 2.32
documentation that you find for future reference.
Perhaps an even better idea would be to convert it
all to PDF files, rather than relying on a fragile paper
copy as your only source of reference.
Gnome 2.32 Desktop User Guide ­ this is a copy of
the official Gnome 2.32 user guide, from the Linux
Mint web site. If you want to know “typical user” stuff
about Gnome 2.32, this is the definitive resource.
Just in case you are unable to access the
aforementioned copy of the Gnome 2.32 Desktop
User Guide, you can also access a copy stored at
the Linux Mint web site.
Ubuntu Pocket Guide and Reference ­ if you stop
and think about it, this one makes sense. Ubuntu’s
“flagship” release is (was) built around Gnome.
Therefore, books that deal with Ubuntu­proper will
obviously have to deal with Gnome.
Mate Wiki ­ just as there is the Trinity desktop fork
for KDE 3.5.x lovers, Gnome 2.32 loyalists have
forked Gnome 2.32. The project’s name is Mate. It’s
only natural to want to keep an eye on this page, as
well as the Mate home page. Since Mate is an
attempt to keep Gnome 2.32 breathing and with a

heartbeat, the information should be applicable to
Gnome 2.32 – at least for a while. Since it only really
got off the ground in December, 2011, given a little
time, it should be quite the source for Gnome 2.3x
information.
Gnome Library ­ there is plenty of Gnome 2.x
documentation still available on the Gnome Library
site. This is one site with literally TONS of
information. The areas are divided into subsections
for users, administrators and developers. Steadily,
and unfortunately, Gnome 3.x data is starting to
supplant the Gnome 2.x information. I do hope that
someone has the foresight to archive the Gnome 2.x
information (Mate developers? Are you listening?)
FreeBSD GNOME Project: Gnome 2.32 ­ FreeBSD
has a good bit of support information for Gnome
2.32. Be selective with the information there. The
information is FreeBSD­centric, so some stuff will
apply, while other things won’t.
Mate Desktop ­ since the Mate Desktop is the
“official” effort to keep Gnome 2.3x alive, you may be
interested in keeping track of what is transpiring with
its continued development. You can also check out
the special Mate Desktop sections on the Ubuntu,
Linux Mint, and Arch Linux forums.
Linuxgator.org ­ finally, PCLinuxOS Gnome has its
own site and forum. This should be the first place
PCLinuxOS Gnome users go for assistance, since
the information is PCLinuxOS­centric. Just as in the
main PCLinuxOS forum, the folks there are very nice
and friendly. In fact, you are likely to see a few
familiar faces haunting the forum there.

Summary
I hope that you have found the magazine’s coverage
of Gnome 2.32 helpful. Since Gnome 3.x has a
special “fallback” mode, I thought it was important to
cover Gnome 2.32 before covering Gnome 3.x. Also,
Gnome 2.32 – or some resemblance of it – should
remain persistent for a while longer. Of course, no
one can tell the future of the Mate Desktop project,
and whether it will fail or succeed. One thing is for
certain: Gnome 2.32, and the Gnome 2.x releases
that preceded it, has left an indelible mark on Linux
history.

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.
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by Patrick G Horneker (phorneker)

This is the WindowMaker article we have all been
waiting patiently for: How to create and use themes.
First, themes for WindowMaker will work on any
operating system that can run WindowMaker.
(Historical Note: The Linux distribution that was
supplied by Sony for its PlayStation 2 back in the
late 1990s used WindowMaker for its default
desktop.)

Where to Place Themes

The first thing we need to know about themes is
where WindowMaker expects to find them on your
system.
For PCLinuxOS, themes that are accessible to all
users on your machine are stored at:
/usr/share/WindowMaker/Themes
Each user on your system can install themes for
his/her own use in the following directory:
~/GNUstep/Library/WindowMaker/Themes
In an earlier article, I showed you where you can
download themes from the Internet. In this article, I
will show you how to create your own themes. When
you download themes from the Internet, you
download a .tar.gz file containing an archive of the
theme to be installed.

About The Theme Archive (.tar.gz file)
The ~/GNUstep/Library/WindowMaker/Themes
directory can be populated with theme archives. You
can leave them as it is (in compressed form), or you
can unpack the archives (using tar ­zxvf <theme
archive>.tar.gz). WindowMaker can work with
these files either way.
We could leave the theme archives in compressed
form to save disk space, but WindowMaker would
have to decompress the file every time we change
the theme. On newer laptops and desktops (with
2GB or more of memory), this should not really be a
concern. However, if you have an older PC (about
Pentium IV or earlier) with 512MB or less, there will
be some delay due to the overhead needed to
decompress the theme archives.
Uncompressing the theme archives allows us to
modify the contents of the theme.
So how do we start a new theme?
First, create a new directory in your userspace. Be
sure to append .themed to the end of your directory
name so WindowMaker will know that this directory
contains the contents of a theme. For example: If
you call your theme MyCoolTheme, then you would
create a directory named MyCoolTheme.themed
somewhere in your userspace.
Tip: Create an empty directory in your userspace
where you can build new themes. Then when you
are ready to deploy your themes on your system,
simply copy the contents of that directory to
~/GNUstep/Library/WindowMaker/Themes to make
your new themes available for use with
WindowMaker.

Tip: Do not use ~/GNUstep/Library/
WindowMaker/Themes to create new themes. First,
anything that goes into that directory is immediately
available to WindowMaker. Second, if you compress
the .themed directory to an archive (i.e. a .tar.gz
file), your theme will be listed twice when you go to
select a theme (one entry for the .themed directory,
and one for the archive file).
If you have a graphical file manager installed, you
may use it to create an empty directory to store your
created themes. However, I recommend using a
command line on a terminal such as xterm,
konsole, or gnome­terminal because of some of
the commands we will be using when we create
WindowMaker themes.

In this example, I used xterm to create an empty
directory (called WmakerThemes) for creating
WindowMaker themes.
Tip: Creating an empty directory allows you to
package themes for distribution (as .tar.gz files)
without disturbing WindowMaker itself. Themes
created here can be used on any computer running
WindowMaker, whether the underlying operating
system is PCLinuxOS, OpenSuSE, Slackware,
FreeBSD, or other any other UNIX dialect.

WindowMaker On PCLinuxOS:WindowMaker Themes



PCLinuxOS Magazine Page 43

What Makes Up A Theme?
A WindowMaker theme consists of:
1. A directory with the name of the theme followed
by the .themed for the required extension.
2. A file called style, containing data that describes
how WindowMaker’s window elements are
displayed. This is required in every theme, and the
file must be named style for the theme to work with
WindowMaker.
3. Graphics that are to be used by WindowMaker.
These graphics are loaded according to the contents
of style, and must be in the same directory as style.
4. Optional: Text files that describe the contents of
the theme, copyright and licensing information,
contact information, etc. These files are for
documentation purposes only, and are
recommended so others who want to know more
about the theme can do so.
In this example, we are in the WmakerThemes
directory. To create a new theme, we shall create a
new directory within WmakerThemes. You can name
this anything you like. Just be sure to append
.themed to the name when you create the directory
so WindowMaker will recognize the theme.
As we have seen when working with WindowMaker
Configuration Manager and Wprefs.app, most every
element that goes into a WindowMaker window is
very configurable. For instance, the title bar can be a
solid color, or it can be a part of a photograph, or it
can be a gradient. A theme can be as creative or as
plain as you want it to be.

An Example Theme
Let us say that we want to create a theme to match
my website. Then, we shall call this theme horneker­
com. With the terminal window open and the current

working directory being ~/WmakerThemes that we
created previously, we create a new directory, then
change to that directory by typing the following:.

mkdir horneker­com.themedchdir horneker­com.themed
Now we are ready to design our new theme.
Note: You can minimize the terminal window to
minimize distraction when creating our theme, but
the terminal will be available when we need it later.
I could have named this horneker.com.themed, but I
have never seen a theme with multiple dots in its
name at any website that hosts WindowMaker
themes.
We have two tools at our disposal to begin the
design: The Configuration Manager, and the
Preferences Applet (WPrefs.app). The latter is
accessed by double clicking on the GNUstep Icon
on the upper right hand corner of the screen (where
the Dock resides).

With the Preferences open, slide the scroll bar to the
right where the tools we need will show in the
window. The second and third buttons to the right of
the toolbar give us what we need, namely colors and
fonts. This is where we go to start the design.

Here we have selected Appearance Preferences.
What we see is a visual tool where we can select
desktop elements to modify. The box on the left
allows you to con the desktop element you want to
work on. As we are editing these elements, changes
appear in this window so we can see what we are
doing.
Here, we have the Focused Window titlebar selected
as the element we are working on. The right side
box contains a visual tool made up of popup menus,
tabs and buttons. To edit this element, click on Edit
in the right box.
Here, we can get into further detail. In this example,
we have a vertical gradient of two colors, with each
color represented as values of red, green and blue.
Selecting the left direction button changes the
gradient to a vertical gradient. The middle direction
button selects a horizontal gradient. The right
direction button selects a diagonal gradient.
Default Color allows you to select a base color of
which you can use in your theme design for each
element.

WindowMaker On PCLinuxOS: WindowMaker Themes
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Clicking on Default
Color opens a color
palette window. Here,
we get a color wheel
from which to directly
select a color.
The slider on the right
side adjusts the
brightness of the
currently selected
color. Notice that as
you use the slider, the
selection is modified to
reflect the change you
make.
The magnifier on the
upper left hand corner
allows you to pick a
color from the desktop
using a “magnifying
glass”. You see a
closer view of the
desktop where the
mouse pointer is
located. Clicking at this
point will select the
color of the pixel where
the mouse pointer is
currently located.
The currently selected
color is displayed on
the color swatch to the
right of the “magnifying
glass”.
You can also select
colors using sliders.
Below the swatch and
magnifying glass are
four buttons. The first
button selects the color
wheel (top, left).

The second button selects sliders you can use to
select your colors (middle, previous column).
There are four sliders for this tool. The first
(displayed here) allows you to select the brightness
of the color (as a percentage of white on the
greyscale).
The second slider allows you to select red, green
and blue values for color. The RGB model refers to
basic components of color for displays and
photographic transparencies.
The third slider allows you to select cyan, magenta,
blue and key (black) values for color. The CYMK
color model refers to the basic color components
used in printing. (This is also why the colors used in
your inkjet printer are cyan, magenta, yellow and
black, and not red, green and blue.)
The fourth slider allows you to select color in terms
of hue, saturation and brightness.
The third button displays the spectrum of colors
instead of a color wheel (bottom, previous column).
There is only one palette to choose from, and only
one spectrum to choose from at the moment.
To this date, I have not seen any installable palettes
for this tool.
The fourth button is used to store names of colors
often used.
For purposes of this article, we shall not worry about
this feature, as there has hardly been any recent
development on this tool.
Changes you make here immediately take effect. To
exit, simply close the window by clicking on the X in
the upper hand corner of the window.
There is a popup menu where you can select the
type of texture you want to use for the desktop
element. Currently, Gradient Texture is selected.

You can select from the following:
Solid Color: Here. you can only select the color to
use.
Simple Gradient Texture: Here, you select two
colors, namely the color where you start the
gradient, and the color where the gradient ends. You
can also select the direction the gradient is
displayed, namely vertical, horizontal or diagonal.
Gradient Texture: Similar to Simple Gradient
Texture, the difference being that you can select
which colors are to be included in the mix, and which
order the colors are to be displayed. This is the
default setting when you open Appearance
Preferences.
Textured Gradient: Similar to Simple Gradient
Texture, the difference here being that the simple
gradient is overlayed on top of an image that you
supply as a parameter. This image must be in XPM,
XBM, JPEG, PNG, or GIF format. You also get the
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option of whether to tile the image, center the image,
rescale the image to fit (with cropping possible), or
maximize the image to fit the element. You can also
select how much of the gradient you want to show
on top of the image (the opacity option).
Image Texture: Here, you supply an image in the
XPM, XBM, JPEG, PNG or GIF format. The image
can be tiled, centered, rescaled (with empty space
possible), or maximized to fit the space. Any space
unused is filled with the color option, that you select
similar to the other options.
With all of these options available, only your
creativity can limit what you can do with a
WindowMaker theme.
Back to our example theme. The graphics on my
website are primarily greyscale images. This is part
of my preference in website design, and greyscale
works with most any device that can display web
pages, including some e­Readers such as the 6­inch
Pandigital Novel (which can only display in
greyscale).
Notice that each element is configured separately.
There are seven desktop elements available,
namely:
Focused Title Bar: This is displayed for the window
that is currently interacting with the keyboard and
mouse.
Unfocused Title Bar: This is displayed for other
windows on the current desktop, except for the
parent of the window that has the keyboard and
mouse focus.
Owner of Focused Title Bar: This is displayed for
the window that has control of the window that
currently interacts with the keyboard and mouse.
Resize Bar: Appearing at the bottom of windows,
this element allows you to resize windows on your
desktop (where possible).

Menu Title Bar: This is the background for the
header of menus that are displayed by
WindowMaker.
Menu Item: This is where the background for menu
items is displayed.
The color and options tabs provide more
configuration options, including color of text items,
and text alignment.
For this theme, I want to use greyscale elements.
Let us start with the title bars. I would like to do
greyscale gradients with the title bars and with the
resize bar. Since the current element being edited is
the Focused Window, we shall start with that. For
this process, we shall click the Edit button to work on
the Focused Window.
For the title bars, I want to create gradients that
have a glossy look. What I am editing now are the
title bars for windows that interact with the keyboard
and mouse.
The colors shown here are from the default theme
for PCLinuxOS. We shall use the Gradient Texture
option rather than the Simple Gradient Texture

option as we will be expanding on the list of colors
shown here.

First, let us edit the basic colors shown here. To edit
a color, simply select a color on the list and use the
slider in the same window.
Tip: To achieve the greyscale effect on colors used
here, set the Saturation level to zero (0), i.e. remove
any intensity of the color hue. When this is done, the
value of hue can be anything you want. For
greyscale values, the hue value is irrelevant.
For most everything in WindowMaker, colors are
represented as rr,gg,bb where rr, gg and bb contain
red, green and blue values (respectively) in
hexadecimal format ranging from 00 to FF.
Mathematical Note: For those of you who are not
familiar with hexadecimal numbers, here is an
explanation for what hexadecimal is. The decimal
numbers is a base 10 system, that is there are ten
numbers possible for a digit whose range is from 0
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through 9. Hexadecimal numbers have sixteen
possible values for a digit. We have all the digits of a
base 10 number, i.e. zero through nine. To
represent values of 10 through 15, the letters A
through F are conventionally used.

Here, I set the saturation to zero (0) to obtain the
greyscale values (of which there are 255).
So far, I have edited the current values so the
gradient starts at (00,00,00) and ending at
(a0,a0,a0). For those of you who are familiar with
CSS stylesheets in website development, (00,00,00)
equates to #000000 and (a0,a0,a0) equates to
#a0a0a0.
We can add (and delete) colors to this list to adjust
the final gradient to what we want. Feel free to
experiment with color choices here. When you have
what you want for the gradient, click on OK to
commit the changes.

To add a color, highlight the line where you want to
insert the new color. Click on Add. A copy of the
highlighted line is made and inserted above where
you highlighted (as shown here).
Add as many lines as you want, then edit each line
so you can build your gradient the way you want it.
In my example, I added two lines and edited the list
so it reflects the following:

00,00,0060,60,6090,90,9020,20,20
...and here is the result of this list.

As we build this list, we can immediately see how
the finished gradient will look.

Next, we need to choose the direction the gradient
will be displayed.

Clearly, we can see which variant can best be
displayed on a title bar.
Since this has already been selected when this
dialog box was opened, we can click on OK to
commit the changes.

As we can see, the change to the theme we are
building is immediate. However, the change does
not take effect in the WindowMaker session until we
click on Save.

WindowMaker On PCLinuxOS: WindowMaker Themes



PCLinuxOS Magazine Page 47

After clicking on Save, we can see the changes to
the current WindowMaker session are immediate.
We can do the same with the other elements of the
desktop.
For the Owner of Focused Window, I used the
following gradient:

40,40,4060,60,6090,90,9040,40,40
For the Unfocused Window, I used the following
gradient:

80,80,80a0,a0,a0e0,e0,e080,80,80
All title bars display their gradients horizontally.
For the Resize Bar, I use the following gradient:

10,10,1090,90,90e0,e0,e0b0,b0,b000,00,00
This gradient, when displayed horizontally, produces
a 3D effect for the resize bar.
For the menus, I used the following gradient for the
title bar:

00,00,0040,40,40a0,a0,a0
The gradient here was displayed horizontally.
For the menu itself, I used the following gradient:

00,00,0000,00,0040,40,40a0,a0,a0
With the color tab, I made the following settings:

Menu item text: ff,ff,ffDisabled item text: a0,a0,a0Highlight Text: 40,40,40
The options tab provides three settings for how the
menus are displayed:
1. Item dividers displayed, with the gradient
displayed inside each item.
2. Item dividers displayed, with the gradient
spanning the entire menu.
3. No item dividers displayed, the gradient spans the
entire menu.
In addition, items can be aligned to the left,
centered, or right justified. For this example, menus
have no item dividers displayed, and the gradient
spans the entire menu.
Finally, I created the following gradient for the Icon
background:

00,00,0060,60,60c0,c0,c0
and made the gradient diagonal, which is best for a
64x64 tile.
Here is the result of the changes to the desktop
elements after going through this example.

Customize the Fonts
WindowMaker allows you to change the fonts
displayed. Sans­serif is the default font used with
WindowMaker as it is available with most any Linux
distribution, as well as FreeBSD, NetBSD,
OpenBSD, or any other operating system that can
run WindowMaker as a desktop.

Here, I have used Nimbus Sans as it is a clean and
attractive font that comes standard with PCLinuxOS,
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Ubuntu, Fedora, OpenSuSE and many other Linux
distributions.
Fonts can be changed for the following:
1. Window Titles
2. Menu Title Bar
3. Menu Text
4. Icon Titles
5. Title on the Clip
6. Desktop Caption (that appears on the center of
the screen when desktops are switched)
Once we have the theme configured so far, we can
close out the Preferences tool.

Create the Style File
Earlier, we opened a terminal window to create the
directory to store the theme. We are going to need
that terminal to create a file called style. This is a
required file for every theme so WindowMaker can
properly use the file.

Creating the file requires a command line interface.
First, open a terminal window and change to the
directory where the theme is stored.

Next, type the following:
getstyle ­p >style
Type ls to verify the style file has been created. The
­p creates a compressed version of the style file.
Normally, this is done to save space. Your terminal
window should look something like the following:

At this point, we have created a basic theme. To
package this for distribution, type the following:
chdir ..
tar ­cv horneker­com.themed/ >horneker­com.tar
gzip horneker­com.tar
We have just created a theme that can be used with
any machine running WindowMaker. Type ls to
verify this.

About the Style File
Typing getstyle (without any parameters) in the
terminal window will display the following with the
newly created theme:
{LargeDisplayFont = "Nimbus SansL:slant=0:weight=80:width=100:pixelsize=72";HighlightColor = "#404040";

MenuTextExtendSpace = "­1";FTitleColor = "#eeeeee";MenuTitleExtendSpace = "­1";MenuTextFont = "Nimbus SansL:slant=0:weight=80:width=100:pixelsize=12";UTitleBack = (mvgradient, "#e9eae9","#808080", "#a0a0a0", "#e0e0e0","#808080");IconTitleFont = "Nimbus SansL:slant=0:weight=80:width=100:pixelsize=10";PTitleBack = (mvgradient, "#000000","#404040", "#606060", "#909090","#404040");WindowTitleFont = "Nimbus SansL:slant=0:weight=200:width=100:pixelsize=12";UTitleColor = "#000000";MenuDisabledColor = "#a0a0a0";ClipTitleFont = "Nimbus SansL:slant=0:weight=200:width=100:pixelsize=10";MenuStyle = flat;MenuTextBack = (mdgradient, "#e6e7e6","#000000", "#000000", "#404040","#a0a0a0");PTitleColor = "#000000";IconBack = (mdgradient, "#0000ff","#000000", "#606060", "#c0c0c0");MenuTitleBack = (mvgradient, "#5772b4","#000000", "#404040", "#a0a0a0");DisplayFont = "sans:pixelsize=10";FTitleBack = (mvgradient, "#000000","#000000", "#606060", "#909090","#202020");WindowTitleExtendSpace = "­1";TitleJustify = left;CClipTitleColor = "#a4a4a4";ResizebarBack = (mvgradient,"#8c8c8c","#101010","#909090","#e0e0e0","#b0b0b0","#000000");MenuTextColor = "#ffffff";ClipTitleColor = "#000000";
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IconTitleBack = "#2b4da0";HighlightTextColor = "#ffffff";IconTitleColor = "#ffffff";MenuTitleFont = "Nimbus SansL:slant=0:weight=200:width=100:pixelsize=12";MenuTitleColor = "#eeeeee";}
Colors here are represented as hexadecimal values
formatted the same as hexadecimal values supplied
on a CSS stylesheet, except the values are
enclosed in double quotes.
Font names are enclosed in quotes and contain the
following parameters:
1. Font name
2. Font style. slant=0 means the font is of normal
type. slant=1 means the font is italicized.
3. Font weight. This determines the thickness of the
font being used.
4. Font width. A value of 100 means normal width.
Smaller values mean compressed type (in terms of
the space occupied by the text). Larger values mean
wider type.
5. Pixel size refers to the size of the font in terms of
the height of the typeface. Usually, this refers to the
point type (72 points to the inch).
For the attributes containing ExtendSpace in its
name, these are boolean values, i.e. the only valid
values are TRUE and FALSE. A value of ­1
represents a TRUE value. A value of 0 represents
FALSE (as one would expect).
Programmer’s Note: Whether we are working with a
32­bit processor or a 64­bit processor, a value of ­1
is represented in binary as a string of 1s. For
example, a 32­bit representation of ­1 is read as
11111111111111111111111111111111. Adding
one to this value resets all bits to zero.

Gradients are represented as lists with the first
parameter being one of the following:
1. mvgradient: vertical gradient
2. mdgradient: diagonal gradient
3. mhgradient: horizontal gradient
WindowMaker reads and processes gradients as
lists. This list is used to render the gradient for the
graphical elements.

Overall, this file looks like a piece of CSS code from
a stylesheet. This is because much of the software
the drives projects like WindowMaker, as well as
standards of the Internet have their roots in the C
programming language, and UNIX in general.
Also, the first web browser (Mosaic) was initially
developed on a NeXT system, which ran NeXTStep
(using a Mach kernel), which was an inspiration for
WindowMaker itself, with a difference being that
NeXTStep (as well as successors Mac OS­X and
iOS) and GNUStep were developed with Objective
C, whereas WindowMaker was developed in C.

Screenshot ShowcaseScreenshot Showcase

Posted by ferry_th, April 6, 2012, running Openbox.
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by Darrel Johnston (djohnston)
I must confess that I have re­installed PC­BSD since
writing the last article. Not once, but twice. Once I
began using the system, I ran out of disk space on
one partition. The partitioning method I chose did not
create a large enough /usr partition. I discovered my
error after the KPorts PBI continually refused to
install. More on PBIs a little later on.
That’s why I reinstalled the first time. I reinstalled
again because the first time around, I installed an
XFCE desktop. That should not have been a
problem. However, once I installed KPorts, it
stubbornly refused to start. I checked error
messages after launching it from a terminal, but
could find nothing conclusive. Believing that the
application might be missing something that is
included in the KDE desktop, I reinstalled a second
time, choosing PC­BSD’s default KDE desktop. And,
this time, I created a 40 GiB virtual disk.
In the Disk setup portion of the installation, I chose
to use the entire disk with a UFS filesystem, just as
before.

Next, I clicked the Advanced Mode tab and clicked
the “Use default layout” button. As a result, the lion’s
share of the disk space was given to the /usr
partition. 34GiB of the disk’s 40GiB, to be precise.

Just before the Installation phase, this was
displayed:

I then installed just as before, but with a KDE

desktop selected instead of XFCE. The KDE splash
screen is shown below.

And the KDE desktop after applying a few
customizations.

The KDE version is 4.7.3.
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An update notifier is part of the standard KDE
desktop, as well as XFCE. On first run, any updates
to existing packages are displayed in a window, with
the option to install them all with a single button
click.

Once the updates are installed, the update notifier
icon in KDE’s system tray will change to a green
shield.

Back to the subject of the /usr partition, you may be
wondering why it needs to be so large. The short
answer is that a lot of files are stored there. Most
BSDs come with native Linux support, and PC­BSD
is no exception. There is a /home directory, but it’s
actually a soft link to /usr/home.
[darrel@pcbsd­2626] ~> ls ­l /home
lrwxr­xr­x 1 root wheel 9 Jan 5 13:00 /home ­>
/usr/home
[darrel@pcbsd­2626] ~>
In addition to user’s home directories being stored in
the /usr directory, many libraries and binary
executables are stored there.
[darrel@pcbsd­2626] ~> ls ­l /usr/
total 84
lrwxr­xr­x 1 root wheel 10 Dec 27 19:58
X11R6 ­> /usr/local
drwxr­xr­x 2 root wheel 7680 Apr 9 23:11
bin
drwxr­xr­x 2 root wheel 512 Dec 27 15:46
games
drwxr­xr­x 3 root wheel 512 Apr 9 23:11
home
drwxr­xr­x 52 root wheel 5632 Dec 27 15:48
include
drwxr­xr­x 7 root wheel 12800 Dec 27
15:48 lib
drwxr­xr­x 4 root wheel 512 Dec 27 15:46
lib32
drwxr­xr­x 5 root wheel 512 Dec 27 15:46
libdata
drwxr­xr­x 6 root wheel 1536 Dec 27 15:48
libexec
drwxr­xr­x 20 root wheel 512 Apr 10 04:44
local
drwxr­xr­x 2 root wheel 512 Dec 27 15:46
obj
drwxrwxr­x 7 root operator 512 Apr 21 19:49
pbi
drwxr­xr­x 67 root wheel 1536 Apr 9 23:09
ports
drwxr­xr­x 2 root wheel 5632 Apr 9 23:16

sbin
drwxr­xr­x 27 root wheel 512 May 18 2010
share
drwxr­xr­x 2 root wheel 512 Apr 10 04:43
swap
After installing Firefox, htop, mc and KPorts, the /usr
directory already occupies 9GiB of disk space.
[darrel@pcbsd­2626] ~> df /usr
Filesystem 1K­blocks Used Avail
Capacity Mounted on
/dev/label/usr0 35177228 9343812 23019240
29% /usr
[darrel@pcbsd­2626] ~>
The 40 GiB disk is already using 16.87 GiB. This is
for a KDE 4 desktop and four user installed
applications. There are practically no data files in my
home directory. And none are of any consequential
size.
You may have noticed a /usr/pbi directory. It holds
any user­installed PBIs. A PBI, an acronym for PC­
BSD installer, or Push Button installer, is a format
unique to PC­BSD. It is a self­contained package
with all files and libraries necessary for an installed
program to function correctly. Any program
dependencies are included in the package.
Previously, this arrangement could end up with
duplicated files all over the system. Beginning with
PC­BSD version 9.0, under Dru Lavigne’s
stewardship, there are now checks in place to
ensure that files are not duplicated when installing
PBIs. Previously, users could download PBIs from
the pbiDIR site and install them locally. With PC­
BSD version 9.0, all PBIs must be installed from PC­
BSD’s AppCafe desktop application.
Because PC­BSD is catering primarily to the desktop
user, they created the PBI format, along with a
simple method of installing these packages. Click
the PC­BSD menu button on the KDE panel and
select System > AppCafe. The main program
window is shown in the next page.
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You can select an Application Category by clicking
on one, then scroll through all the selections. There
are a lot of categories and many, many more
program selections. If you already know the name of
the program you want to install, simply type it into
the search window. Oddly enough, entering mc does
not bring up the program. But, entering midnight
does.

Click the Midnight Commander icon (top center).

A summary of the program is shown. To install,
simply click the Download arrow. You will get a
dialog window asking if you want to download and
install the program. After answering Yes, download
and installation progress will be shown in the
Installed tab of the AppCafe window.

The ports tree is the traditional BSD method of
installing binary packages. KPorts is a PBI I installed
in order to use a GUI to access program ports. The
PBI description reads:

KPorts is KDE­Frontend to the FreeBSD­Ports and
in future also to the OpenBsd­Ports, PkgSrc and
maybe others. You can browse and search through
your Portstree and perform actions like Upgrades,
Installs, Uninstall a.s.o. More advanced features like
setting Options and Vulnerability checking are also
available. For a complete list, check the Homepage
or the Changelog. Functionality is KPorts\' main
goal, not simplification by reducing options however
KPorts should be rather easy to use. A new version
of KPorts based on completely new code and Qt4 is
available @ /usr/ports/ports­mgmt/kports­qt4 NOTE
that the new version cannot yet compete with this
version feature­wise.
I wanted to include the use of KPorts in this article.
Unfortunately, every method I’ve used so far fails to
launch the program. Neither kdesu kports nor
kdesu dbus­launch kports works. The program
window appears on the desktop for about one
second, then disappears. I get no clues from the
error messages in the console window as to what
the problem is. Running the program as user root
doesn’t work, either. Entering just kports in the
terminal window tells me I need to be root to run it.
However, the PBI description states: “Requires
Root: NO”
The next and last article on PC­BSD will show how
to use the ports tree to install and update programs.
If KPorts GUI is still not working by then, I’ll cover
using the traditional CLI methods.
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by longtomjr

This is a nice little drop­down terminal for Linux. It is
very useful. When I press F12, it drops down from
the top of the screen. I can kill a program, or when
I do some Python I can use it as a python shell. This
will be also useful for the people who are doing bash
and packaging.
It also has a nice soft appeal to the eye and with
some other themes and a transparent window,
I think this is a very useful tool.
Change your Linux experience forever, and get
Yakuake.

A Short Review: Yakuake

http://www.pclinuxos.com/?page_id=213
http://www.pclinuxos.com
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Posted by lkj, April 24, 2012, running LXDE. Posted by brilz, April 2, 2012, running Openbox.

Posted by smileeb, April 16, 2012, running KDE4.

Posted by
Meemaw,
April 26,
2012,
running
Xfce.

More Screenshot Showcase






